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USING WINPOKER 6.0 TO STUDY GAMBLING BEHAVIOR
James W. Jackson
Southern Illinois University
Previous technical efforts have described how custom computer programs for
the study of gambling behavior may be created to allow for the manipulation of
variables not readily available in natural gambling contexts, however many
people may lack the technical repertoires necessary to make such efforts feasible.
The current paper discusses how a commercially available Video-Poker simulation and training software package, WinPoker 6.0, may be employed to study
gambling behavior.
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___________________

It is difficult to ignore the growing emergence of gambling activity in our culture at
large in recent years. Over the past three decades an increase in the legalization of gambling in some form throughout the US has
been observed, with now 48 states offering
some type of legal wagering, where 30 years
ago only two did (Ghezzi, Lyons, & Dixon
2000). Advances in technology, namely the
Internet, have also increased accessibility and
familiarity with gaming activities for most
individuals (Griffiths, 1999; Griffiths & Parke,
2002). In addition, increasing television coverage of gambling activities such as the World
Series of Poker on ESPN or the World Poker
Tour on the Travel Channel could be moving
traditional viewpoints of gambling from a
harmless vice or recreational activity to an
accepted form of sport (Wilstein, 2005). This
increasing popularity and acceptance does not
come without a price however, with reports of
the rate of pathological gambling at between
1-2% of the population worldwide (Petry
2005).
While in relative terms this may seem like
a small number, it represents millions of

people who fall within the strictest terms of
the clinical criteria for pathological gambling,
and does not include many others who may
still suffer problems from their gambling, yet
fail to display the criteria for a pathological
diagnosis.
While pathological or problem gambling
represents a significant social concern, research on gambling as a whole has occurred
within a relatively narrow scope. Research in
the field of gambling as a whole has focused
primarily on the assessment of pathological
gambling and the maintaining variables of
forms of gambling such as video lottery terminals, slot machines, horse racing, VideoPoker, and table games such as craps and roulette (Black & Moyer, 1998: Cox, Lesieur,
Rosenthal, & Volberg, 1997: Dickerson &
Adcock, 1987: Kallick, Suites, Dielman, &
Hybels, 1976). Research into the controlling
variables of gambling behavior has focused
on various theories including cognitive mediated theories, biological or psychobiological
theories, and operant theories (Dickerson &
Adcock, 1987; Dixon & Schreiber, 2004;
Friedenberg, Blanchard, Wulfer, & Malta,
2002; Griffiths, 1989; Ladouceur, Sevigny,
Blaszczynski, O’Conner, & Lavoie, 2003,
Sharpe, 2004).
While there is certainly massive need for
basic experimental research on gambling, the
experimental analysis of gambling behavior
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presents many challenges. First of all, from a
behavioral perspective, there are a severely
limited number of researchers who would
identify themselves as primarily interested in
the study of gambling. In addition, based on
governmental regulation of gambling and basic ethical concerns in research, it is difficult
to conduct studies on gambling behavior with
a reasonable amount of internal or external
validity (Weatherly & Phelps, 2006).
Legal provisions against owning and operating actual gaming machines that can be
found in US casinos as well as their prohibitively high cost make the purchase and use of
actual gaming machines such as slot machines
and Video-Poker terminals for research generally infeasible. In addition, if one can procure such machines there are provisions regarding tampering with how they work, which
can severely limit one’s ability to program
specific outcomes that may be needed for the
level of experimental control necessary to answer a given research question.
Some researchers have tried to work
around these issues with varying degrees of
success. For example, MacLin, Dixon, and
Hayes (1999) and MacLin, Dixon, Robinson
and Daugherty (2006) have written on how to
create a computerized slot machine simulation
for conducting behavioral research. Simulation software for both Video-Poker and roulette have been created and offered free of
charge to anyone willing to conduct research
into these games (Dixon, MacLin, & Hayes
1999; MacLin, & Dixon, 2004). To date most
of the research that has employed these software solutions has been primarily focused on
slot machines (Christopherson & Weatherly,
2006; Weatherly, McDougall, & Gillis, 2006;
Weatherly, Sauter, & King, 2004), with only
one published study presenting data either
using the published roulette or Video-Poker
software (Dixon & Schreiber, 2002).
Another potential solution is to make use
of commercially available gambling simulation software. This paper will describe one
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such piece of software, WinPoker 6.0 (Zamzow Software Solutions, 2007), a commercially available Video-Poker simulation and
trainer which can be purchased for approximately $30. The purpose of the current paper
is to describe this software and to discuss how
it may be employed to study gambling from a
behavioral perspective. This paper will describe the multitude of potential independent
and dependent variables that can be studied
using WinPoker 6.0.
WinPoker 6.0
WinPoker 6.0 is a commercially available
Video-Poker simulation and trainer that sells
for approximately $30 (Zamzow Software
Solutions, 2007). Video-Poker is an electronic game based on variations of standard 5 card
draw poker using a standard 52 card deck.
Like slot machines, Video-Poker is a single
player game with a relatively simple interface
that most anyone with any level of experience
can play. Where Video-Poker differs from
other single player games such as slot machines is that based on the specific VideoPoker game variation being played and the
payout structure for that game, an actual strategy may be employed which can result in
rates of return of greater than 100% over the
long run. In addition, even the least favorable
configurations of Video-Poker offer rates of
return of greater than 90%, when played correctly. The above mentioned software is advertised as training software to help improve
your return on your gambling investments in
actual casinos. WinPoker 6.0 offers various
training modes to help users learn to make the
statistically correct decision based on the specific game and payout structure employed.
From a research perspective, however, this
software can be put to more academic uses.
The nature of the structure of the software
offers many potential avenues for research in
to gambling behavior.
Potential Independent Variables.
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Formal Properties
Prior research in gambling has examined
the effects of contextual stimuli and discussed
the impact that formal properties of gambling
machines may have on behavior (Hoon, Dymond, Jackson, & Dixon, in press; Parke and
Griffiths, 2006; Zlomke & Dixon, 2006).
WinPoker 6.0 offers the ability to manipulate
various formal properties of the game structure including sound, deck color, card back
style, and coin drop display. By clicking on
the “Options” tab on the Main Menu, one can
see many of these options.
Credits and Betting Amounts
The software also offers the user the ability
to start with a predetermined number of credits between 1 and 1000. By clicking on the
“Player” tab on the Main Menu and selecting
from the available options one can choose to
reset the current number of credits to zero or
to buy a specific number of credits. What
these credits are “worth” depend on what the
coin drop display is set at or what instructions
are given to whoever is playing the game.
The coin drop display can be set at 6 levels
including 5¢, 25¢, 50¢, $1, $5, and $25.
Like most casino versions of Video-Poker,
players can choose the number of credits they
wish to wager at the start of a hand up to a
maximum limit. In the case of this software
players can wager from 1 to 5 credits per hand
in single line play. One potential manipulation that could be employed could consist of
limiting the amount that a player may wager
on a given hand. While the software does not
offer specific settings to limit amount bet, this
could be accomplished either through instructions or experimenter monitoring or a combination of the two.
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Games and Payout Tables
WinPoker 6.0 features many manipulable
features that in a research context can be put
to use as potential independent variables for
study. First and foremost amongst all of these
features are the number of different specific
and user defined Video-Poker variations built
into the software. WinPoker 6.0 features 22
preset Video-Poker variations. These games
feature many of the most popular variations of
Video-Poker that may be found in real casinos,
including Jacks or Better, Deuces Wild, Bonus Poker and many others. To choose from
the many variation of Video-Poker offered
one needs to simply click on the “Games” tab
on the Main Menu and select from the game
options. The left panel of Figure 1 displays
the included games. In addition the software
offers the ability to create up to 10 user defined games, by clicking on the “Games” tab
and selecting the “Define” option.
WinPoker 6.0 also offers information on
the Total Return for all of the included games
when played perfectly as well as the Game
Variance for each game. This information
can be accessed by clicking on the “Analyze”
tab from the main menu and selecting the
“Game” option. In addition to this information for the preset games, the Total Return for
a User defined or custom game can be calculated from this screen by clicking on the “Run
Analysis” button.
In addition to defining whole games the software also features the ability to modify the
payout tables on existing games. One can
change existing pay tables by clicking on the
“Options” tab on the main menu and selecting
the “Change Pay Tables…” option. From the
resulting screen, the pay rate for each hand for
all available games can be modified as displayed in the right panel of Figure 1.
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Figure 1.The left panel of Figure 1 displays the available Video-Poker Gamer variations in
WinPoker 6.0. The right panel of Figure 1 displays the modification of a pay table in the WinPoker Pay Table screen.

Multiple line play
One variation of Video-Poker that can be
found in most casinos allows players to play
multiple hands at the same time. WinPoker
6.0 offers multiple Multi-Play options, allowing players to play 3, 4, 5, or 10 hands at a
time, which can be accessed by clicking on
the “Multi-Play” tab on the main menu. In
this type of variation, a player chooses an
amount to wager per hand (1-5) credits, and is
then dealt a hand. The player chooses which
cards they would like to keep, and then gets to
see the results of a number of different draws
depending on which Multi-Play game is chosen. For example in a 10-play version of
Jacks or Better a player could choose to wager the max of 5 credits on a hand, which when
multiplied by the number of hands in this variation would mean that he/she is wagering 50
credits total. The player would then be dealt a
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hand and would choose which cards to keep
as displayed in Figure 2. The player would
then get 10 separate draws based on the card
kept and cards remaining in the deck, and
would earn all of the credits won across all 10
draws. These Multi-Play variations might
offer a potential to study variations in betting
patterns and decisions in multiple line games.
Training Modes
First and foremost this software is marketed as Video-Poker training software. WinPoker 6.0 offers 5 different training modes to
alert players of errors in play and to teach the
correct play based on the given Video-Poker
variation. These different modes can be toggled on and off by clicking on the “Training
Modes” tab on the main menu or by clicking
on the bottom gray button above the “Bet 1
Coin” button on the main game play screen,
and
are
discussed
below.
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Figure 2. A 10 Play version of Jacks or Better

Figure 3. The warning pop up box and the Hand Details screen available under the Warn
Training Mode.
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Warn
One training mode is called the Warn
mode. In this training format players are
alerted every time they make an error by a
pop up window in the middle of the screen as
displayed in Figure 3. This pop up window
informs the player of the severity of the error
in play (minor, moderate, or major) and gives
them specific information on how much the
error is costing them in the long run. The
window also informs the player of the expected value or return of the correct play as
well as the expected return of the play the
player is currently attempting to make. The
pop up window gives the player the option of
continuing with the chosen play or returning
to the game to change cards currently held.
This mode, does not easily display what the
correct play is, unless one clicks on the “Details…” button on the pop up. The Hand Details screen as displayed in figure 3 shows the
expected returns for each of the 32 possible
hold combinations in descending order, with
the best play displayed at the top. The Hand
Details screen also displays the total number
of possible hands that could result based on
the cards held as well as the number of those
possible hands that will result in no winning
combinations, and the number of those possible hand combinations that will result in any
of the winning combinations listed in the
payout table.
Autohold
The Autohold training mode automatically
chooses the correct cards to hold for the player. If the player chooses to change the cards
held and play the hand differently, the same
“Statistical Error” pop up warning as described for the Warn mode will be displayed.
Test
As with the Warn and Autohold modes, the
Test training mode will inform a player of a
playing error, however, it differs in that it
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does not allow the player to correct that error.
As displayed in Figure 4, the software informs the player of what cards should be held
and which ones should not, by the display of
the text “Hold” or “Draw” beneath the card as
well as the severity of the error (Major, Moderate, or Minor). In addition the Test mode
offers access to the Hand Details screen described previously for the Warn mode. The
player may only continue with the hand play
as chosen however, and cannot correct the
error.
Show
The Show training mode is very similar to
the Test training mode. As with the Test
training mode, the Show training mode displays the correct cards to hold and offers
access to the details screen; however it does
not inform the player of the severity of the
error.
Advanced Training Mode
WinPoker 6.0 also offers an Advanced
Training mode with allows the user to practice with various types of hands or “Deal
Types”. This mode can be turned on by clicking on the “Training Modes” tab on the main
menu and selecting the “Advanced” option.
This mode differs from the other training
modes in that it only allows players to choose
which cards to hold and does not actually allow them to see real outcomes. From a behavioral standpoint, this mode offers the most
potential to study patterns of play while controlling for the effects of reinforcement or under extinction conditions. While in the Advanced Training mode players do not see the
result of the decisions made, this mode can be
combined with the previously described training modes to provide players with additional
feedback on errors being made.
The Advanced Training mode offers the
ability to analyze play with multiple types of
hands or “Deal Types”. This mode can be set
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Figure 4 The feedback offered under the Test Training Mode.
to display “Normal (Random)” hands. It can
also be set to only display “Hard Hands”.
What defines a “Hard Hand” is customizable,
but by default is set to any hand where the
differential of the Expected Value of the best
play and the second best return Expected Value is less than 2 coins/credits. This training
mode also features the ability to allow the
player to set the specific hand dealt. Finally
this mode features a setting to choose hands
from an error log of the last 100 errors.
Figure 5 shows the display under the default settings of the Advanced Training Mode.
This mode by default displays an Advanced
Window which displays many of the settings
and results from play in the Advanced Training Mode. From this window one can choose
from the Deal Types described above, view a
log of all errors that are currently saved to the
error log, set the parameters of what qualifies
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as a “Hard Hand”, or clear the current statistics. From this window one can also see the
number of hands played as well as the number
of errors committed. This window also displays the expected return based on play thus
far as well as the overall cost of the errors
committed. The visibility of this window can
be toggled on and off so that players may either see constant feedback on these results or
can continue to play with no feedback. To
toggle the visibility of this window one can
click on the “Training Modes” tab on the
main menu and select the “Hide Advanced
Window” option.
Error Thresholds
Throughout the description of the various
training components of WinPoker 6.0 described here, how the software can report on
the severity of playing errors, by labeling
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Figure 5. The feedback provided in the Advanced Training Mode with the Advanced Window displayed.

Figure 6. The Set Training Mode Thresholds window for setting the thresholds of Minor,
Moderate and Major Errors.
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Figure 7. Multiple instances of WinPoker 6.0 opened on a single computer with the game on
the left featuring the Autohold Training Mode and the game on the right with no Training Mode.
errors on a 3 level continuum including Major,
Moderate, and Minor errors has been mentioned. Another customizable feature of this
software that could serve as a potential independent variable consists of the thresholds for
these error labels. Under the “Training Modes” tab of the main menu is an option for Error Settings. These error continuums are
based on the cost in cents that each error
represents per play, and can be individually
set for each different coin value setting for the
game as can be seen in Figure 6.
Options for Concurrent Responding
A final feature of WinPoker 6.0 makes it a
very attractive option for studying gambling
behavior under conditions where concurrent
responding options are made available. With
WinPoker 6.0 you can open multiple instances of the game on a single computer. In
addition you can apply completely different
settings to each open instance of the game on
a given computer. For instance, as displayed
in Figure 7, you could open 2 instances of
WinPoker 6.0 where the settings differ along
a single dimension (in the case of the Figure 7,
the game in the left panel has the Autohold
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Training mode turned on displaying the correct play, while the game in the right panel
has no training mode turned on). Such variations offer opportunities to measure the allocation of responses on two concurrently
available games.
This ability to open multiple instances of
the software to present multiple games in
some sort of array on a single computer may
offer certain considerations along the lines of
external validity when noted that actual casinos often present banks or arrays of similar
but different games from which casino patrons may choose to allocate their gambling
dollars to.
Dependent Variables
Thus far we have discussed how many of the
built in options and elements of WinPoker 6.0
may be potentially manipulated to serve as
potential independent variables for study.
However, more importantly we need to consider what type of behavioral measures we
can get from this software that may serve as
dependent variables of study.
Win Poker 6.0 offers many built in analysis features that are intended to give the
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Figure 8. Two methods of accessing the available Hand Counters
user feedback as they learn to improve their
play on each type of Video-Poker game
played. While these features may be intended
for the improvement of an individual’s play,
they can also serve the purposes of a creative
researcher when it comes to measuring the
behavior of a gambler. In the measurement
of behavior of any kind, we are often interested in a number of features of behavior, namely, frequency, rate, duration, and in the study
of gambling behavior this is no different.
When it comes to potential elements of behavior we may wish to study within the context of an individual playing Video-Poker,
there are many options that are available to us.
We may simply be interested in the frequency
or number of hands an individual plays over a
given period of time. We may want to translate this information into a calculation of their
rate of play. We may have some interest in
the amount that an individual bets under various conditions of play. We may wish to
measure the number of coins played, amount
bet per hand, etc. In discussing the training
options available with WinPoker 6.0 errors
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have been described in some detail. We ultimately may wish to examine frequency or rate
of errors for a given individual under various
game conditions. We may also be interested
in recording the specific errors that an individual makes for further analysis. In addition,
any gambling activity is an activity of probabilistic reinforcement, and we may wish to
record the actual outcomes of an individuals’
play in regards to rates of return, coins won,
or Payback percentage. The built in feedback
options in WinPoker 6.0 give us direct access
to many of the potential dependent variables
described above, and one may also be creative
and employ additional measures or direct observation when the built in features lack the
specificity necessary for a given research
question.
Hands Played
Win Poker 6.0 has a couple of built in features for keeping track of the number of hands
played. In the upper right of the main playing
screen, WinPoker 6.0 features a running
counter of hands played as can be seen in
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Figure 8. This counter can easily be reset by
clicking on the red button to its right. In addition to this counter, WinPoker 6.0 keeps a
separate count of hands played in a detailed
session history screen which may be accessed
by either clicking on the “Session” button in
the middle right of the main game play screen,
or by clicking on the “Analyze” tab on the
main menu and selecting the resulting “Current Session” option. The hand counter in the
“Current Session Analysis” screen and the
one featured on the main playing screen are
independent of one another and one may be
reset without affecting the other.
Current Session Analysis
Above it was discussed that the hand information available in the “Current Session
Analysis” screen which may either be accessed via the “Session” button on the right of
the main playing screen or through the “Analyze” tab on the Main Menu. This screen, as
displayed in Figure 9, offers a wealth of information that can be used for data collection.
Specifically this screen reports information on
Hand Results, Playing Errors, Coin Results,
and the Error Effect on Total Return.
Hand Results
The Hand Results section of the “Current
Session Analysis” screen offers information
regarding the number of hands played during
the current session, the duration of the current
session can be seen in the Session Time box,
and the rate of play can be seen in the Hands
per Hour box.
Coin Results
The Coin Results section of the “Current
Session Analysis” screen offers information
regarding the amount wagered and the results
of those wagers overall. The number of credits wagered or coins played can be seen in
the “Coins Played” box. This information
could be combined with the number of hands
played or the session time in order to calcu-
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late average wagers per hand or the rate of
wagering. This section also gives information
regarding the overall outcome of the hands
played and credits wagered over the current
session. The number of coins won can be
seen in the “Coins Won” box and this is translated into an overall percentage return that is
displayed in the “Payback %” box. Overall
the number of coins either won or lost is seen
in the “You Lost” box (if a profit had been
earned for the given session this would be
displayed as a “You Won” box).
Playing Errors
The accuracy of game play decisions can
be seen in the “Playing Errors” section of the
“Current Session Analysis” screen. The total
number of playing errors can be seen in the
“Total Errors” box with the number of errors
of each level of severity seen in the “Minor”,
“Moderate”, and “Major” error boxes. Based
on the number of hands played these errors
translate in an overall percentage of correct
play that is displayed in the “% Correct” box.
Error Effect on Total Return
The effect of errors made on the overall
rate of return of all of the wagers made in the
current session is displayed in the “Error Effect on Total Return” section. The best return
possible for the current session if no errors
were made is displayed in the “Best Return”
box, while the actual return for the current
session based on the actual plays made is displayed in the “Your Return” box. These
numbers translate in a percentage of possible
return for the current session that is displayed
in the “Return %” box. Subtracting the actual
return from the best return results in an overall cost of the errors made in the current session in coins that is displayed in the “Cost in
Coins” box.
Using the Current Session Analysis
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Figure 9. The Current Session Analysis screen displays Hand Results, Coin Results, Playing
Errors, and the Error Effect on Total return for the current session.

Figure 10. The WinPoker Play Analysis screen displays the overall results for each game.
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The different pieces of information described above that are displayed in the Current Session Analysis are potentially the most
important potential sources of data. Weatherly, Austin, and Farwell (2007), examined the
effects of self reported poker “experience” on
playing errors and amount wagered in three
different Video-Poker games using the WinPoker 6.0 software described in this article.
In this study the authors examined differences
between experienced and inexperienced poker
players on a number of dependent variables
including number of hands played per session,
error rates as measured by the % Correct statistic, credits wagered per session, and bet
size per hand. All of these variables were
recorded from the Current Session Analysis
screen.
While Weatherly et al. (2007) employed a
group design which required recording data
from the Current Session Analysis one time
per subject; this screen could also be employed to collect repeated measures in a single subject design study. For example, if one
wished to conduct a study measuring the effects of some type of training program on
percentage correct play, one could have a participant play for either a preset amount of
time or number of hands. The Current Session Analysis screen could then be opened
and data recorded. One could then reset all
information to zero by clicking on the “Reset
Numbers to Zero” button, close the screen,
and let the participant continue playing. This
pattern could be continued until stable responding is assessed and then the training program could be employed and repeated measures could be taken to observe the effects of
the training program.
WinPoker Play Analysis
While the Current Session Analysis screen
described above may offer the best method
for recording more immediate or molecular
levels of behavior, the “WinPoker Play Analysis” screen may offer a method for recording
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more molar data of overall play. The WinPoker Play Analysis screen as seen in Figure
10 can be accessed by clicking on the “Analyze” tab on the main menu and selecting the
“Overall Play” option. This screen displays
results for all available games. Each available
game can be selected from the drop down box
in the upper left of the screen as displayed in
Figure 10. Each type of possible outcome in
the chosen game as well as the number of
times they have occurred over the “Total
Hands Played” for the given game as well as
the resulting percentage of outcomes are displayed on the left of the screen. In addition
many of the pieces of information described
previously for the Current Session Analysis
screen such as the Coin Results, Playing Errors, and Error Effect on Total Return are displayed on the right side of the screen.
View Playing Errors
The final source of potential dependent
variables that we would like to mention is
displayed under the Advanced Training Window described previously. As described previously, you can turn on the Advanced Training mode by clicking on the “Training Modes”
tab on the main menu and selecting the “Advanced” option. If the Advanced Training
Window is toggled on, you can view a log of
the last 100 errors for each game by clicking
on the “View…” button to the right of the
“From Error Log” button. This will open the
“View Playing Errors” window as seen in
Figure 11.
This window allows you to see detailed results for the currently chosen game including
a detailed view of the last 100 playing errors
that were made. This screen displays the
cards that were dealt for each error across the
top, with the cards that actually were held indicated by the text “Held” above the cards,
and the cards that should have been held indicated by the text “Hold” beneath the cards.
One can cycle through the last 100 errors by
clicking on the left and right arrows on the
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Figure 11. The View Playing Errors window under the Error Log in the Advanced Training
Mode displays detailed information on the last 100 errors and total history for the currently chosen game.
left side of the “For the error displayed” area
in the middle of the window. This area also
displays the classification of the severity of
the error, the best Expected Value for the
hand dealt if the correct play was made, the
actual Expected Value of the hand given the
way it was played, as well as the cost in cents
of the error that was made.
Beneath this area the window displays a
summary for the history of the currently selected game beyond the last 100 errors including all errors that have ever been made and
their classification, the overall number of
hands that have been played in the current
game, as well as the best expected return given perfect play, the actual return based on the
errors made, as well as the calculated return
percentage and overall cost of the errors that
have been made.
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Limitations of WinPoker 6.0
While all of the above mentioned potential
dependent measures can serve many purposes,
there are other possible variables of interest
that WinPoker 6.0 does not keep track of that
many potential researchers could have some
interest in. While the software does not keep
track of these measures, a creative researcher
may still find ways to record additional variables of interest through direct observation
or other means.
One specific limitation of WinPoker 6.0 is
that it does not keep a direct record of each
hand that an individual plays. While as mentioned previously it is possible to access
records of the last 100 errors made on the
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Table 1
Potential Research Questions That Can Be Addressed Using WinPoker 6.0
Potential Research Questions
Which training format offers the best method of increasing percent correct responding to a specified criterion?
Do “experienced” video-poker players make different types of errors than “inexperienced players?
Which game variations do players show the highest rates of errors879 on?
Does experiencing the outcome of game play decision facilitate or decrease the
length of training necessary to decrease error rate to a specified criterion?
Does training on one game format effect play on other game formats?
What effect does error feedback have on number of hands played?
What effect does error feedback have on total coins bet?
What effect does error feedback have on average credits bet per hand?
What effect does the amount of money credits are worth have on total amount bet,
hands played, error rate, or amount bet per hand?
Does training differentially affect the rates of different types of errors?
What effect do adjustments to the payout table on a given game have on “experienced” players?

game, however, if a researcher wished to examine every hand that a participant had
played over the course of a session including
the specific cards dealt, cards help, and
amount bet, methods to do so would have to
come from outside of the existing software.
One possible solution may be to employ any
of a number of software options for taking
screen capture video (i.e. Camtasia Studio
(Techsmith Corporation); CaptureWizPro
(PixelMetrics), ACA Screen Recorder (ACA
Systems)). Direct recordings of variables of
interest could then be made from these videos
at the leisure of the researcher.
Another potential variable of interest
which WinPoker 6.0 has not method to record
is latency between responses. The latency
between gambles in both Video-Poker and
other games of chance such as slot machines
have been examined by researchers and have

Published by theRepository at St. Cloud State, 2007

been found to differ based on the outcome of
the gamble (Dixon & Schreiber, 2002: Dixon& Schreiber, 2004). In addition, using the
software developed by Dixon, MacLin and
Hayes (1999), Dixon and Schreiber (2002)
recorded the mean decision time between
deals and draws in Video-Poker. While WinPoker 6.0 does not record these variables, it is
not hard to envision how one could employ
direct observation either with an actual observer, through the use of screen capture video recording as described previously, or
through a camcorder set up to record the actual screen display to create a direct record of
behavior from which latency can be measured.
While the two above mentioned areas of
limitation described above for WinPoker 6.0
do not exhaust all of the potential shortcomings of this software, they do represent two
areas in which WinPoker 6.0 falls short of
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previously described video-poker software
solutions when it comes to dependent measures (i.e. Dixon, MacLin, & Hayes, 1999).
Additional areas of concern or limitations that
might arise are going to depend on the specific research question being asked. However a
wealth of research questions could be addressed using WinPoker 6.0 and make it a
very attractive and available tool for the study
of gambling behavior. In addition the wealth
of manipulable features available with this
piece of software dwarf those offered in previously described pieces of software (i.e. Dixon et al, 1999), and make the limitations
mentioned seem less significant.
Table 1
displays a list of potential research question
that could be addressed using WinPoker 6.0.
This list in no way exhausts all of the possible
questions this software could be employed to
address, but should serve as an indicator of
the potential contribution of WinPoker 6.0 to
a research program interested in studying
gambling.
Overall WinPoker 6.0 offers a readily
available and relatively inexpensive (approximately $30) option for studying gambling
behavior. The fact that it is specifically designed to simulate and train individuals to
play many of the more popular versions of
Video-Poker found in actual casinos, make it
a very attractive option for studying VideoPoker gambling. As described in the current
paper many of the built in features intended to
help individuals better their Video-Poker
strategy lend themselves well towards both
dependent and independent variables of interest in the study of gambling behavior.
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